Take your eBooks with you!

Download the Bookshelf app.

If you own an iPhone, iPad, or iPod Touch, you can download the new “Bookshelf” app. Go to: [http://itunes.apple.com/](http://itunes.apple.com/) for more information.

If you own an Android Device you can download the new "Bookshelf” app via the Google Play Store. Go to: [https://play.google.com/store](https://play.google.com/store) for more information.

Easily access, navigate, and read your eBook on your mobile devices!

Alternatively, can you go directly to [http://digitalbookshelf.aionline.edu](http://digitalbookshelf.aionline.edu) in your mobile browser and login. Follow the steps above for accessing the Digital Bookshelf Online.
contents

What is the Art Institutes Digital Bookshelf? ................................................................. 4
  Support ......................................................................................................................... 4
  Accessibility .................................................................................................................. 4
  Digital Bookshelf Online ............................................................................................. 4

Technical Requirements .............................................................................................. 5

Accessing Your eBook for the First Time ...................................................................... 6
  Creating Your Account ................................................................................................. 6

Using the eBook Online .............................................................................................. 8
  Navigating the eBook .................................................................................................. 8
  Searching ....................................................................................................................... 8
  Accessing Figures ......................................................................................................... 9
  Highlighting and Note Taking ....................................................................................... 9
  Managing Notes and Highlights ................................................................................. 10

Downloading the Digital Bookshelf .............................................................................. 12
  Downloading Windows .............................................................................................. 12
  Installing the Bookshelf ............................................................................................ 14
  Downloading to Mac OS ............................................................................................ 15
  Installing the Bookshelf ............................................................................................ 16

Setting up the Digital Bookshelf on your Desktop ....................................................... 17

Using the Digital Bookshelf ....................................................................................... 20
  Navigating the Bookshelf Window ............................................................................. 20
  Managing Highlighters and Notes ............................................................................. 21
  Sharing and Subscribing ............................................................................................ 21
  Navigating the Book Window ..................................................................................... 22
  Making Highlights and Notes ................................................................................... 23
What is the Art Institutes Digital Bookshelf?

Given that we are in an age of digital information sharing, it is imperative that students learn how to use technology and multimedia resources effectively. We believe we would be remiss if we did not integrate these assets into the context of the classroom and provide students a rich learning environment. As a result, we will be incorporating electronic textbooks (eBooks) as an essential part of the Art Institute student experience.

The Art Institutes Digital Bookshelf is an advanced electronic textbook platform and will be the tool used to provide access to the majority of your eBooks. This bookshelf is available in multiple places, allowing you the ability to access and read your textbooks in many convenient ways – online via the online classroom, the Digital Bookshelf Online (http://digitalbookshelf.aionline.edu), mobile devices, and via desktop software, allowing you to download your books and read from a personal computer.

Support
For support using the Digital Bookshelf or downloading the Bookshelf application to your computer, contact Technical Support at:

1-877-872-8869

If you receive any type of error message immediately after clicking on an eBook link in the online classroom, please refer to the directions of that message.

Accessibility
Any students with an accessibility concern with the Digital Bookshelf related to a disability or impairment should contact the Office of Disability Services at aiods@aii.edu or 1-877-872-8869, extension 33000.

Any students with an accessibility concern that is not related to a disability or impairment should contact their Academic Counselor.

Digital Bookshelf Online
You can also access the Digital Bookshelf Online directly by going to http://digitalbookshelf.aionline.edu.
Login to your Digital Bookshelf account using the email and password you entered previously when creating your account.
Technical Requirements

**Bookshelf Downloadable (via a PC/Mac)**

**Software Requirements:**
- Windows XP SP2 (32 bit) / Windows Vista (32 or 64 bit) / Windows 7 (32 or 64 bit)
- Windows users are also required to install Microsoft .Net 4.0
- Mac OS 10.6 or greater

**Hardware Specifics:**
- gHz or greater processor
- 512 MB of RAM or greater
- 1024x768 resolution monitor/display or greater
- Internet Connection for registration and downloading of eTextbook
- Quicktime 7.6 or greater is needed for embedded video content

**Bookshelf Online (via Web Browser)**

For a PC:
- Internet Explorer, Mozilla Firefox, or Google Chrome (latest two versions)

For a Mac:
- Apple Safari, Mozilla Firefox, or Google Chrome (latest two versions)

**Bookshelf Mobile (via a Mobile Devices)**

A WiFi connection on the mobile device is required for a book to download.

**Phone/iPad/iPod Touch**
- iOS 3.2 or higher

**Android Devices**
- Android 2.2 or higher

**Kindle Fire**
- Kindle Fire 1.1 or higher*

*Please note: VitalSource Bookshelf for Kindle Fire only work with a Kindle Fire. It will not work with any other Kindles, Android Phones/Tablets, or the Barnes & Noble Nook.
Accessing Your eBook for the First Time

**Note:** In each term and in each course, you must always follow these same steps for accessing your eBook for the first time.

1. Enter the online classroom. Click on the link on the left-side navigation bar where the readings are found. This typically is called "Readings and Assignments" and is found under the "Course Home."

2. Then, locate the chapter that you want to read or access, and click on the chapter link.

3. A pop-up window will appear with a message that reads, "Please wait while we connect you to your eBook." The duration of this connection process will depend on your internet speed and connectivity.

Creating Your Account

**Note:** You must only complete the account creation steps once.

4. You will then arrive at a screen where you must create your Digital Bookshelf account. Enter your information into the fields listed and click "Continue."

**NOTE:** You will need to recall the email and password information at a later point, so do not forget what you have entered here.

If you have already created a Digital Bookshelf account, it is very important that you enter the same email and password at this step as associated with your existing account. This will allow the Digital Bookshelf to match your pre-existing account to your eBooks via the online classroom. You may have already created a Digital Bookshelf account if you were enrolled in a course requiring use of the Digital Bookshelf at a local campus.
This screen will only appear the first time you attempt to access an eBook. After the initial access, you will be taken directly to the reading. This will also be the case in each subsequent course.

If you enter an email address that already exists in the Digital Bookshelf system, but an incorrect password for that account, you will receive an error message. If this occurs, you can request the password for your pre-existing account be sent to you via email. Once you retrieve your password, attempt to access your eBook again.

After completing this form and clicking "Continue," you will receive a confirmation email at the email address you have entered.

5. Next, you should be presented with an End User License Agreement. By acknowledging this license agreement, you are agreeing to accept responsibility for improper use of the materials. Please read the license and accept it to move on to the next step. To do this, ensure the box next to "Accept license agreement" is marked, and click "Continue."

6. Your eBook will then open. If you clicked on the link for a particular chapter, you will arrive at that specific chapter in the eBook.

Welcome to the Digital Bookshelf!
Navigating the eBook

To begin, let’s talk about how to navigate in your eBook. As you can see, there are three main navigation areas. In fact, navigating your eBook is similar to navigating the online classroom.

1. The top navigation bar provides some tools, including a search field and a button to make highlights.

2. The left-side navigation bar provides the table of contents for the eBook. All the items in the table of contents are linked so that you can jump wherever you need in the eBook. Click on the arrow to the left of a chapter title to expand the section and jump to a more specific location in the text.

3. In the center frame, you see the eBook itself. This is where you will read and scroll through the content. Use the left and right arrow buttons to move from page to page.

Searching

One of the tools on the top navigation bar is the search tool.

Enter any text or concept, and the Digital Bookshelf will search the entire eBook.

The search results will then be presented on the left-side navigation bar.

Click on any of the presented search results to jump to the place in the book where that search result is located.

To return to the normal table of contents after executing a search, click "Contents" on the left-side navigation bar. This will remove your search results and instead display the table of contents.
Accessing Figures

Next, click on the "Figures" button, which is the icon that looks like a picture on the left-side navigation bar. This allows you to view figures found in the book. This could be graphics or graphs and charts.

If you use the drop-down menu, you can look for figures in certain parts of the book – your options typically mirror items found in the table of contents.

Highlighting and Note Taking

One of the nice features about eBooks is that you can still use them as you would a hard copy textbook. You may like to highlight items that are important and that you want to be able to find easily. You can do the same thing with your eBook.

Simply use your mouse cursor to select the text you want to highlight, and on the top navigation bar, click "Make Highlight."

The item will then be highlighted in your textbook. Once you create highlights, they are easy to find.

To easily add a note, delete the highlight, or change the highlighter color, simply click on the highlight in the text. A pop-up toolbar will appear, presenting those options.

Now, to the left-side navigation bar. You have three features across the top of the left-side navigation bar. These will help you better manage and navigate the content in the book.

Click on the "Contents" button, which is the icon that looks like a piece of paper. This brings up your table of contents. Using the table of contents, you can click to jump to any listed location in the textbook.
Managing Notes and Highlights

Lastly, click on the "Highlights" button on the left-side navigation bar. This allows you to manage all of your highlights, attach relevant notes, and more. If you want to add a note associated with your highlight, click "Add Note."

If you want to change the color of the highlighter for a specific selection, click the Change Highlighter button and simply click on the color of your choosing.

If you want to change the color or titles for your highlighters in general, add new highlighters, delete highlighters, or enable sharing, click the following button and click “Manage Highlighters.”

If you want to manage your highlighters, click on the highlighter and you can edit the name, color and sharing options for that particular highlighter. You can also manage your subscriptions here. You can select Private, Friends or Public to allow other users to view highlights with the selected highlighter. You can add friends to see your highlights by adding them to the “Add Friend” box at the bottom – you just need their first and last name, along with their email address.

Another way to enable your subscriptions to others highlights, click on the following button Then choose “Manage Subscriptions”.

This tool will allow you enter the email address of someone who you would like to subscribe to.
Copying – You can copy text from an eBook to paste in a new location.

To copy and paste, simply select the text that you want to capture using your mouse cursor, and from the options provided, click "Copy." Or use “Ctrl” + C. You can then paste the content where needed.

If you are using a Mac, use the "Apple" or "Command" button, plus the "C" button to copy. In your document, click the "Apple" or "Command" button, plus the "V" button to paste.

Automatically create citations or page links for material you are citing in papers and posts. To do so, click the “Cite/Link” button in the bottom right corner of the Book window. Click on the citation format you prefer – MLA or APA. Then, copy that citation to your Works Cited or Bibliography.

Jumping to a specific page by page number – While the “Contents” tab provides very efficient navigation in the textbook, a user might need to jump to a very specific page location. The following tool can be used to do so. Page numbers in an eBook reflect the page numbers from a hard copy version of the textbook.
Downloading the Digital Bookshelf

Go to: http://vitalsource.com/downloads

Once there, use the radio button to choose your platform, and click the arrow (reading “Click to Download”) to download the Bookshelf application.

Downloading Windows

Note: Screenshots below represent Windows XP, however, the instructions listed to the left remain the same for Windows Vista and 7.

1. A "File Download" window will appear. Click “Run.”

2. When the download is complete, click "Run."

   If using Windows 7 or Vista, you might receive a separate window in which to click "Run."

   Note: If using Windows 7 or Vista, you might be presented with a warning immediately after clicking "Run." This states, "A program needs your permission to continue." Click "Continue" to move to the next step.

3. Choose the setup language and click "OK."

   If you do not see this window, it may be located in the tray at the bottom of the Windows screen.
Microsoft .Net 3.5 SP1

If this is not already installed on your computer, the application will install it at this time. If already installed, this step will be skipped. This may take several minutes to install. This is required in order for the Bookshelf application to be installed.

4. If Microsoft .Net 3.5 SP1 is not installed on your computer, you will be presented with the following screen. Click "Install."

5. When prompted, accept the terms of the License Agreement by marking the radio button next to "I have read and ACCEPT..." The "Install" button will then become active. Click "Install" to move to the next step.

6. Microsoft .Net 3.5 will then download to your computer and will begin to install.

7. Once finished (it may take several minutes, so please be patient), you must exit and restart your computer.

**Note:** You may see the box from the first step (see step #4) in the background. You should not cancel the installation.
8. Once your computer has restarted, the installation will begin again. Click the "Run" button to allow the Bookshelf to be installed.

9. Once again, choose the setup language and click "Ok."

**Installing the Bookshelf**

10. The "VitalSource Bookshelf – InstallShield Wizard" window will open. At the first screen, click "Next."

11. Accept the license terms by marking the radio button next to "I accept the terms..." and then click "Next."
12. Click the "Next" button once again, and then, at the following screen, click "Install."

13. Lastly, click the "Finish" button. The "VitalSource Bookshelf" icon will then be available on your desktop.

**Downloading to Mac OS**

1. The "VitalSource_Bookshelf_5.2.dmg" file will be downloaded to your desktop (10.4.X) or your "Downloads" folder (10.5.X and 10.6.X).

2. If the "VitalSource_Bookshelf_5.2.dmg" file does not open automatically, then double click on the file (either on your desktop or the "Downloads" folder) to open on your computer.
Installing the Bookshelf

3. In the "Bookshelf" window, drag the "VitalSource Bookshelf" icon to the "Applications" folder.

4. Close the "Bookshelf" window and then, on your desktop, eject the "Bookshelf" icon by dragging it to the trash can.
Setting up the Digital Bookshelf on your Desktop

Note: Screenshots below represent Windows XP, however, the instructions remain the same for Windows 7, Vista, and Mac OS X.

1. Open the Digital Bookshelf by clicking on the icon for "VitalSource Bookshelf" on your desktop. If using a Mac, select the "VitalSource Bookshelf" icon from the "Applications" folder.

2. A license agreement will appear. Click "Accept" to agree to the terms of the license. You must accept this agreement in order to open the Bookshelf application.

3. The VitalSource Bookshelf will open.

4. Enter the email address and password that you used when you created your account via the online classroom. Once the form is completed, click "Sign-in."

5. By signing into your account, the Bookshelf should then recognize that you have book(s) available for download (the same book(s) you are accessing via the online classroom). You can choose to download immediately or download later.

Note: If you do not receive this "download" window, it is likely that you have not successfully signed in to your account (the same account that you set up via the online classroom). Please contact Technical Support for assistance in this case.

6. If you choose to download your book(s), you can follow the status of the download in the main Bookshelf window.

7. Then, once downloaded, double-click on the book listing in the main Bookshelf window to open the book.
Updating Your Book List

You can always access your eBook via the online classroom. In addition, you will also have the opportunity to download the eBook to your personal computer using the Digital Bookshelf software.

During the first 16 days of class, you can download a temporary license for your eBook. This expires on the 16th day of the term. After this time period, the full license for the eBook is available. Both license types allow you to access the entire textbook. Updating your license/book list will allow you to access your eBook after this initial temporary license has expired and for up to 5 years.

For instance, if you download your eBook to your personal computer during the first 16 days of class, you will receive an expiration warning, shown to the right.

In this case, and in the event that you see this same expiration message, you will need to access your eBook through the online classroom again in order to obtain the full license for the eBook. You must do this after the temporary license has expired. Then, follow the steps below to update your license/book list.

Note: If you have multiple eBooks in a term, we suggest that you click on the links for each separate book title via the online classroom before proceeding with the steps below. This will ensure you update all books on your book list at the same time, versus having to complete this process multiple times.

1. Go to your online classroom and click on the eBook link again. This assigns the full eBook license to your account. This step must be completed before a book list update will be effective.

2. Then, go to the Digital Bookshelf on your desktop. From the top toolbar in the Bookshelf application, select "Account." From the drop-down options provided, select "Update Book List."

3. The system will then attempt to contact the server and find any updates to your book list.

4. As long as you have again accessed the eBook(s) via the online classroom, you should then be presented with a window that indicates you have new book(s) to download. These are actually the same book(s) for your class, but now with a full license for accessing them.

Although it indicates that "you have recently purchased new books," no additional fees apply for downloading your eBook(s) beyond the Digital Resource fee already applied to your account.
Downloading Bookshelf to a Second Computer

You can download the Bookshelf software to two personal computers. If you would like to utilize the Bookshelf on a second computer, please follow the steps below.

1. Install the Bookshelf software following the steps that begin on page 12. Once Bookshelf has been downloaded, launch the program.

2. Sign-in using your existing Bookshelf account by entering your email, password and clicking “Sign-in.” **DO NOT** register for an account. Contact Technical Support if you need assistance with this step.

3. Once signed in, the books in your account will automatically populate.
Navigating the Bookshelf Window

In the main Bookshelf window, you can navigate to all your books, folders, and highlighters, as well as preview the contents of those items (in the far right "Inside the Book" column).

Most of your navigation is done on the left-side navigation bar – expanded to the right. At the top of this navigation window, there is a toggle button. Using this button, you can turn on and off the "Inside the Book" column that will allow you to see the contents of books, notes, and highlighters.

Within the left-side navigation bar, you can access all your books and other assets. These will be organized by different categorizations.

At the bottom of the left-side navigation bar, you have three "add" buttons. You can add folders, add new highlighters, and subscribe to others' shared highlights.

In the Bookshelf Window, you can search. In the top right corner, enter a word or phrase in the search field and all of your books will be searched. The search results will be presented in the center pane.

If you click on one of the search results, the book will open. The table of contents will list all chapters and the number of search results found in each chapter. Opening a chapter, the search results will be displayed and highlighted.
Managing Highlighters and Notes

To add a new highlighter, click on the "New Highlighter" icon in the bottom left corner of the Bookshelf Window. You can immediately enter the name of the new highlighter.

Right-click on the highlighter on the left-side navigation bar and select "Change color..." to change the color for the highlighter.

By double-clicking on the highlighter name on the left-side navigation bar, you can change the title of the highlighter, if needed.

Sharing and Subscribing

You can also share your highlights and notes with friends and classmates.

Begin by clicking on the highlighter that you want to share on the left-side navigation bar. At the bottom of the center pane, mark the box next to "Share this highlighter with:" and then use the radio button to indicate "Anyone" or "Friends Only."

If you select “Anyone,” it allows any person who subscribes to your highlights to see them.

If you select “Friends Only,” you control the individuals who can subscribe to your highlights. Click the "Edit Friends" button to add friends to the list. You must know the email for their Digital Bookshelf account in order to properly allow them access to subscribe to your highlights. Enter their name and email and click "Add Friend." Upon subscribing, they will see your highlighter in their highlighter list and your highlights and notes will appear in any book you both own.

If another user has elected to share a highlighter, you can subscribe to see them. At the bottom of the left-side navigation bar, click on the "Subscribe" icon. In the provided pop-up window, type in the email address for the user whose highlights to which you would like to subscribe. Then click "Subscribe." Note that you can only subscribe to highlights that person has elected to share.

Highlights from another user will show their name and an icon in the highlight list.
Navigating the Book Window

By clicking on a book in your Bookshelf, it will open the text in a separate window. In this new window, you will read and navigate in your eBook.

To customize how you view material, there are various tools provided across the top toolbar.

1. The "Navigation" toggle hides or unhides the table of contents on the left-side of the window.
2. The "Page Layout" button allows you to choose three options for viewing the book – Browser View (text is on one page, scrolling vertically), Columns View (text is laid out like a newspaper, scrolling horizontally), or Reading View (text is laid out like a book, with a single page per view).

You will also find tools on the top toolbar for interacting with your book.

1. The "Back" and "Forward" buttons take you backwards and forwards to the pages you recently visited in the textbook.
2. The "Related Items" button will allow you to see other titles in your library that are related to the book you are currently viewing.
3. To highlight a section, you can choose the highlighter color from the "Highlights" drop-down menu. Then use the available buttons – "Highlight" and "Make Note" to complete those actions after selecting the text in the book.
4. Lastly, you can alter the text size in your book for preference of reading.

If you click the "Bookshelf" button, you will return to your main Bookshelf window.
Now, over to the left-side navigation bar.

At the very top of the left-side navigation bar is a search field, allowing you to search within the book.

Using the tabs, you can view contents, terms, figures, and notes.

The "Contents" tab will display the table of contents, which will allow you to jump to any location in the book by clicking on that section title. Click on the arrow to the left of a chapter title to expand the section and jump to a more specific location in the text.

The "Terms" tab provides a quick reference of defined terms in the book. Click on a term to see the location in the book where it is defined.

The "Figures" tab displays all images and tables in the book. Click on the figure to see the place in the book where the figure is located. You can also use the drop-down menu to narrow the figures down to a specific book section.

If you double-click on a figure, it will open that figure up in a separate window, allowing you to manipulate that figure for better viewing (features include zoom, grab, and toggle caption).

The "Notes" tab will display all highlights and notes associated with the book.

Following a search at the top of the left-side navigation bar, the tabs will be filtered by that search criteria.

Making Highlights and Notes

To make a highlight in your textbook, simply select the text with your cursor, select the highlighter color from the drop-down menu across the top of the window, and click "Highlight."

To make a note associated with a highlighter, simply select the text with your cursor and click "Make Note." Enter your note in the available pop-up window. Keep in mind that notes are associated with highlights. If you select text, and it is not already highlighted, a highlighter will be applied to that text (it will apply whatever color was pre-selected in the highlighter color drop-down menu).

Alternatively, to make a note, right-click on the highlight in the text. From the menu provided, select "Add note to highlight."

For nearly a century following Columbus's first voyage, Spain was the dominant nation on earth. No peoples, either in Europe or in the Americas, were able to challenge Spain's power in the New World. Midway into Queen Elizabeth's reign, however, half-brothers, Humphrey Gilbert, who had been sent by the English Court to establish an English settlement in any part of the world a Spanish man or any other prince," and Sir Walter Raleigh, who actually possessed as his

23
Try these additional tools!

**Jumping to a specific page by page number** – While the “Contents” tab provides very efficient navigation in the textbook, a user might need to jump to a very specific page location. The following tool can be used to do so. Page numbers in an eBook reflect the page numbers from a hard copy version of the textbook.

From the Book window, select “Go to Hardcopy Page...” from the “Book” menu. In the pop-up window, enter the page number value.

**Printing** – You can print a chapter at a time from the downloaded version of the eBook.

Click on the chapter that you would like to print from the left-side navigation bar (“Contents” tab). Then, select “Print” from the “File” menu. The “Print Preview” window will automatically present you with the page range of the selected chapter. Click “Continue” to proceed to normal printing steps.

**Fast Highlights** – This allows you to preselect your highlighter color, and it will automatically highlight the text in your book once you select it. This most closely simulates physical highlighting in a book.

From the Book Window, select “Fast Highlights” from the “Book” menu.

**Update Book List** – There may be multiple occasions on which you would like to update your book list.

1. You have passed the add/drop period and would like to replace the expired, temporary version of the book with the fully-licensed version.
2. A new edition of the textbook has been made available to you.

Select “Update Book List” from the “Account” drop-down menu (in the main Bookshelf window).

**Changing the book colors** – Personal reading preference allows each user to change the background and text colors of a book for easier reading.

From the Bookshelf or Book window, select “Preferences” from the “Edit” menu. Click on the “Colors” tab from the “Preferences” window. Click on any color to be presented with a color menu for selection. Click “OK” when done.

**Screen Reading** – If ever needed, you can employ the imbedded screen reading technology in the Digital Bookshelf to read the textbook out loud. The voice will read any text on the book page where you are located.

**On Windows**, open the book. In the Book Window, select “1 Start Speaking” from the “Book” drop-down menu. Select “2 Stop Speaking” from the same drop-down menu to stop the reader.

**On a Mac**, open the book. In the Book Window, select “Speech” from the “Edit” menu. Additional options will be presented to the right – choose “Start speaking” or “Stop speaking.”
Synchronize!

Now that you have accessed your eBook via the online classroom and downloaded the Bookshelf to your personal computer, you want to make sure that your accounts sync. Syncing means that if you create a highlight in the online version of your eBook, that highlight will also appear in the downloaded version of your eBook (and vice versa). This also applies to displaying notes and highlights on a mobile device.

The first option for syncing your accounts is automatic and is the easiest way to complete the task. The second time that you open the Bookshelf from your desktop (by double-clicking on the icon or opening from your "Applications" folder), you should be presented with a pop-up screen.

This screen asks, "Would you like to enable notes and highlights syncing?" To do so, click the "Enable Syncing" button. You only need to complete this task once. Syncing will then be enabled.

If you are not presented with the pop-up window above on your second use of the Bookshelf application on your desktop, or you want to change your syncing setting, follow these steps.

From the top toolbar in the main Bookshelf window, select "Edit." From the drop-down options provided, select "Preferences."

On a Mac, select “Bookshelf” from the top toolbar in the main window. From the drop-down options, select “Preferences.”

In the window that appears, select the "Syncing" option. Then, on the syncing screen, mark (or unmark) the box next to "Sync highlighters between all my computers." Click “OK.” You can then close the "Preferences" window.